An Introduction to Cabri 3D v1.1

By Kate Mackrell

This introduction is for Cabri 3D version 1.1.0 and uses ideas from a workshop given by Eric Bainville at CabriWorld 2004, a presentation by Jean-Marie Laborde at the T3 conference in March 2005, and the first version of this introduction written for Cabri 3D version 1.0.1.

The first part of this introduction will introduce a few important features of Cabri 3D.  

Some important features:

1. Toolboxes.

Here are the possible toolboxes: 
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Each toolbox contains a number of tools.   

	For example, here is the curves toolbox, with the vector tool selected.

To use a tool, first select it, either by clicking on the toolbox if the tool you want is the one that is visible, or click, hold down and drag to the required tool to change the visible tool.  

Next, select the objects to which you will apply the tool, or click to create points to which the tool will be applied.
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For further details concerning the toolboxes, see pages 13-20 in the user manual accessible through the Help menu.  This is an Adobe Acrobat file: it is useful to keep it open as you work.

2. Creating and manipulating points.

	Click on the point tool.    

Create a number of points:  in space, on the plane, or at the vertex of any of the three base vectors.
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Now press Shift and try to create a point on the plane.  What happens?  This is very useful when you don’t want to create a point on an object.  

	Now drag some of the points you have created.  

What happens? 

 What happens if the point is on the plane?


	
[image: image4.png]




	Press Shift and drag some points. 

What happens? 

What happens if the point is on the plane?
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3. Rotating the view.

The view is the rectangular box that fills most of the screen in which constructed objects are displayed.  

Right-click in an empty spot in the view, hold down and drag.

	Alternatively, make sure that the Active View panel is visible on the right side of the screen (make it visible via the Window menu). 

Drag the Auto Rotate slider – what happens?
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4. Labelling objects

Construct the line joining two of your points and immediately type in a name for the line.  All objects can be labeled “on the fly” immediately after being created.  To label  previously constructed objects, select the object and type in a name.

	To change a label, double-click on it.  

To change the colour or font of the label, or to mask/show or delete it, right-click on it.  

A contextual menu will appear – choose Label Colour or Label Font.
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5. Masking (hiding) and showing

Note that this differs from Cabri 2/2+, and also from the earlier versions of Cabri 3D.

	Right-click on one of the points you have created.  

A contextual menu will appear (which will also allow you to change the appearance of the point).  

Choose Mask/Show. 
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	To show the point:  make sure that the Active View panel is showing (use the Window menu if not) and click on Show Masked Objects.

Right-click on the point and choose Mask/Show to make it visible once again.
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Creating Claude

Claude (pronounced Klowd) is a new child of Cabri 3D.  The name Claude can be used for both men and women in France.  Claude likes to do active things – see the files Swing and Trampoline for examples of what Claude can do.
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Your next task is to create Claude – and create Claude in such a way that Claude can be moved without falling apart.  

	Use this task as an opportunity to explore the various toolboxes – and to begin to experience some of the challenges of construction in 3D.

Make sure that the Tool Help panel is visible (use the Window menu).
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Sometimes objects need to be chosen in a certain order.  With some transformations (e.g. central symmetry) you need to choose the objects which define the transformation before choosing the object to be transformed (which in some cases is the reverse order to Cabri 2+ or to earlier versions of Cabri 3D).

Claude has a few problems

There are some orientation problems with Cabri 3D.  The effect is that sometimes objects will suddenly switch orientation in certain configurations.  For an example of this problem, open the file “swing” and drag the swing over the top.  Claude’s arms and legs will suddenly switch direction. It is not yet known whether these problems are avoidable (it has been proven that a 2D dynamic geometry software cannot be both consistent and continuous and that hence orientation problems cannot be entirely avoided in 2D).

Making a Cube

Challenge : create a shape which will fold up into a cube using only one perpendicular line and some rotations.

Hint :  Imagine (or construct !) the net of a cube out of a piece of paper.  What transformations are needed to fold this up into a cube ?

Details :

	Start with a square.

Read the tool help instructions carefully to see what you need to select to create the square.
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	Create segment PQ and then the circle with axis PQ passing through O.
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	Rotate the square about segment PQ :

Choose PQ,
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	Choose the square.
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	Choose two points which have the required angle between them.
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	The rotated image is formed.
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	The new point on the circle is labelled R.
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	Now the square with centre R is rotated about the vertical vector through O.

Select this vector.
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	Select the square.
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	Select point Q.
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	Select point P.
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	This new square is then rotated similarly, and its image is also rotated.
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	The vertical vector through O is extended into a line.

The line perpendicular to the square with centre R and passing through point R is created.

The intersection S of these two lines is found.
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	The square with centre O is now reflected (central symmetry tool) in point S to create the final face of the cube.

Select S.
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	Select the square.
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	Alternatively, the square with centre O may be rotated about the perpendicular line through R to create the final face.
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Challenges :

Using a similar technique, construct a foldup dodecahedron or icosahedron.

There are some wonderful shapes to be discovered here !
Constructions using Cabri 3D


You can attempt each of the following constructions in several ways :  with no further guidance, with some hints, or with full details of the steps involved.  

Each construction is followed by suggested extensions.

Choose the level of challenge that suits you best. 

Square-based Pyramid

See appendix 1 for the Cabri 1.0.1 construction which does not use regular polygon tools.

Hint :  What is the base ?  Where will the top vertex be ?  

Details:

	Create a square using the square tool (select the plane, then click to create the centre point and click to create one vertex).

Label the centre A.
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	Create a new point at the vertex just created and label it B (unless you do this you will not be able to drag the point).

You might want to do the same for the other vertices in order that they have labels – but this is not necessary for the construction.
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	Construct the line perpendicular to the square (or the base plane) through A.
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	Create point M on this line.
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	Construct the triangle shown
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	Now construct the other three triangles
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	Select one of the faces and experiment with changing its colour and style via the right-click menu.
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Extensions :

1. How else could you have constructed the pyramid ?

2. Can you construct a pyramid with equilateral triangles for faces ?

3. Can you construct a prism rather than a pyramid ? A non-rectangular prism ?

4. Experiment with adding to your pyramid : can you use the pyramid to create an octahedron ?  A regular octahedron ?

5. Construct a truncated pyramid, which has as top face a square of area : 

(a)  1/4 the area of the base,  (b) 1/16 the area of the base, 

(c) (harder) 1/9 the area of the base.

6. Experiment with cutting off the vertices of the pyramid.  Is it possible to construct a solid with four triangular faces, one square face, four hexagonal faces and one octagonal face ?  Can these faces be regular polygons ?

The Platonic Solids

The regular polyhedra toolbox will enable you to create each of these. (You need to choose either a regular polygon or the face of an existing polyhedron or a plane, a face centre and a vertex).  Experiment with these, and fill in the following table :

	Regular Polyhedron
	Shape of Face
	Faces
	Vertices
	Edges

	Tetrahedron
	
	4
	
	

	Cube
	square
	
	8
	12

	Octahedron
	
	
	
	

	Dodecahedron
	
	
	 
	

	Icosahedron
	
	20
	
	


What relationships can you see in this table ?

The following are screen shots from files in which only the regular polyhedra tools have been used.  See if you can reproduce any of these.

	Adding a sllightly different view (Documents – Add View – Central Perspective – Infinite distance) helps make this «convincing »
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	Hint :

This is not entirely made of tetrahedra.
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	Try some other combinations of these shapes.

Is it possible to make a stellated icosahedron this way ?  

Make sure you know the accurate definition of stellated in answering this question.
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	A game to learn about parallel and perpendicular.

Start with any configuration of cubes, and two points A and B.  The aim is to construct segments to form a continuous path from A to B.  The segments must be parallel to cube edges..

How many ways can this be done ?  How many segments are necessary ?

Make a really complicated arrangement, or an arrangement based on polyhedra other than cubes.
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You are now going to construct each of the Platonic solids without using the regular polyhedra toolbox.

Regular tetrahedron

See Appendix 2 for the Cabri 1.0.1 version of this construction in which you will need to construct the base.

The regular tetrahedron has 4 faces (equilateral triangles), 4 vertices, and 6 edges.

Label the point where the base vectors meet O, and create a point A on the base plane. Construct a regular tetrahedron having one face in the base plane, centered in O and having A as a vertex. 

Hints :  

1. What is the base of the tetrahedron ?

2. Where will the top vertex be ?

Details :

	Create a triangle on the base plane. 

Label the centre O and create a point at the vertex used to create the triangle.

Label this point A.
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	Create and label the other vertices and then construct the perpendicular to the triangle passing through O.
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	Construct segment AB.
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	Now construct the circle with axis AB passing through point C.

You might want to experiment with constructing circles by all methods possible – note that a centre point and a radius point are not enough to specify a circle in 3D.
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	Construct point D, the intersection between the ccircle and the perpendicular through O.

Point D will be the fourth vertex of the tetrahedron – why ?
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	To understand why D is the fourth vertex, you might want to construct M, the midpoint of segment AB and then construct segments joining M to D and M to C.
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	To construct the tetrahedron, use the tetrahedron tool (not the regular tetrahedron tool) and select the four vertices A, B, C and D.
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Extensions :

1. Construct the tetrahedron given two vertices A and B.

2. By ‘cutting off ‘ vertices, use the tetrahedron to create a solid made of 4 triangles and 4 hexagons. How can you construct this so that the hexagons and triangles are regular?

3. Create the above solid so that the amount that is cut off any particular vertex is dependent on one point on one edge.  What sort of solids are possible as this point moves?  What happens if the point can move beyond an edge?

4. Create segments joining the midpoint of each edge to the midpoint of the opposite edge?  How are these segments related?  What can you say about their intersection point?

5. Find the centre of the tetrahedron and reflect the vertices in this centre.  Join these vertices to form a second tetrahedron intersecting the first.  The shape made of the two intersecting tetrahedra is known as a stella octangula.  What properties does it have?

Regular octahedron

This solid has 8 faces (equilateral triangles), 6 vertices, and 12 edges. 

Using the previously constructed regular tetrahedron, construct a regular octahedron.

Hint : How can you easily construct 6 symmetrical points to be vertices of the octahedron ? 

Details :

	Hide the tetrahedron and find midpoints between each pair of adjacent vertices.  

For example, G is the midpoint of edge DC.
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	Either make each face as a triangle or use the polyhedron tool and choose all the vertices (in any order).
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	Here is the octahedron with the framework of the tetrahedron constructed. 
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Extensions :

1. How else can you construct a regular octahedron ?

2. How can you use a regular octahedron to construct a tetrahedron ?

3. What sort of solids can you make by truncating the vertices of the octahedron ? 

4. What solid do you get if you create a regular tetrahedron on every face of the octahedron ?  (predict before you try constructing this).

Cube

The cube has 6 faces (squares), 8 vertices and 12 edges.

	This construction begins with the previous construction of the regular tetrahedron.  
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Hint :  Will a tetrahedron fit inside a cube ?  How can you create the extra vertices that you need ?

Details :

	Hide the tetrahedron, create segments for each edge, and find the midpoint of each of the edges.
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	Create a segment joining any two opposite vertices (segment FH is drawn here) and also a segment joining O to the top vertex D.

Point L is the intersection of these segments and is the centre of the tetrahedron.
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	Unnecessary points have been hidden and the bottom triangle has been shown for clarity.

Find the reflection of each of the tetrahedron vertices in point L.

Use the tool shown and first select point L.

The reflection of A is A’, etc.

These points, together with the original tetrahedron vertices, form the vertices of a cube.
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	You can choose the polyhedron tool and select all the vertices to form the cube.

It’s not entirely obvious, however, which vertices form the individual faces and hence it’s more interesting mathematically to create the faces individually as polygons – or even to find their centres and then use the square tool.  
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	The completed cube, with the base plane made visible.
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Extensions :

1. How else can you construct a cube ?  Can you start from the base vectors and base plane only ?  Can you start with an octahedron ?

2. Explore the relationship between the diagonals of the faces of the cube and the tetrahedron, and create a tetrahedron from a cube using these diagonals.  Now create a second tetrahedron using the diagonals perpendicular to the ones you used for the first tetrahedron.  Describe the solid composed of the two intersecting tetrahedra (this is known as a stella octangula, discovered by Kepler in the 17th century).  See also extension 4 for the octahedron. 

3. Can you construct an octahedron from a cube ?

4. Explore truncations of the cube.

5. How is the volume of the tetrahedron related to that of the cube ?

Regular dodecahedron

The regular dodecahedron has 12 faces (regular pentagons), 20 vertices and 30 edges.

This construction start from a cube – if you use your previous construction, it’s useful to hide all but the cube.

Hints:  

	Look at the file “dodeca-from-cube” in the examples – Platonic_Solids folder (under Cabri 3D in the Program Files folder) and choose one of the dodecahedron vertices that is not also a cube vertex.  

On what plane does this vertex lie?  

On what circle does this vertex lie?
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	Further hint:  Create a line through two opposite vertices of the cube, and join the top vertex to one of the dodecahedron vertices as shown.  

This may help you to find the circle upon which the vertex lies.   


	[image: image59.png]





Details :

	Taking as axis the "vertical" diagonal of the cube, create one of the two circles containing three vertices of the cube. 
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	Find the midpoint of the vertical diagonal, and construct the three lines parallel to the edges of the cube and passing through this point.  

These lines will go through the centre of the faces. 
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	Now create the plane containing any two of these lines and find its points of intersection with the circle.

Hide the plane and repeat for both other possible pairs of lines. 
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	You should now have six points on the circle in addition to the three cube vertices.
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	These six points define two equilateral triangles.  Hide the three vertices of one of these triangles and hide the vertical diagonal of the cube.

Now reflect each of the three points in each of the three lines (half-turn tool), to obtain nine further points (shown in grey in the diagram).   
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	These twelve points, together with the eight cube vertices, form the vertices of a regular dodecahedron.  

Join the points with segments to form the framework of the dodecahedron, and create polygons for the faces.
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Extensions :

1. What happens if you now repeat this with the three equilateral triangle vertices which were originally hidden ?

2. How could you vary this construction ?

3. Extend the edges and create a stellated dodecahedron.

4. Explore truncations.

5. Can you use the regular dodecahedron to create any other regular polyhedra ?

Regular Icosahedron
The regular icosahedron has 20 faces (equilateral triangles), 12 vertices and 30 edges.

This construction will start from a dodecahedron.

Hint :  The icosahedron has twelve vertices and the dodecahedron has twelve faces….

Details :  

	It’s useful to start with the file “dodeca-from-cube” in the examples – Platonic_Solids folder (under Cabri 3D in the Program Files folder) if you have not constructed your own dodecahedron.  

First, find the red point that moves and resizes the cube and label it m.  Manipulating this point enables quick manipulation of the dodecahedron. 

Now hide the cube and its edges.
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	Find the centre of a face.  These centres will form the vertices of the icosahedron.  

Find the midpoint of any two edges bordering a face and create segments joining these to the opposite vertices.  

The intersection of these segments is the centre of the face.

	[image: image69.jpg]




	You can either find the centre of each of the 12 faces, or alternatively find the centre of the dodecahedron (intersection of segments joining opposite vertices).
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	Reflect (central symmetry) six of the centres in this point to create the other six centres. 

In the diagram to the right, the centres of 3 faces have been found and reflected in the dodecahedron centre to construct the three white points, centres of the three opposite faces.
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	Join the twelve centres with segments to form the framework of the icosahedron and create triangles for its faces.
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Extensions :

1. How else could you have constructed a regular icosahedron ?  

2. Find the centre of one of the pentagons.  Now find the centre of all the others using rotation.

3. Explore stellations and truncations of the regular icosahedron.

4. Can you use the regular icosahedron to create a regular dodecahedron ?

Lines, Points and Planes

Problem 1 :  

	Create two skew lines u and v (not in the same plane) and a point P which is not on either line.  

Now construct a line which passes through point P and intersects both of the lines u and v. 
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Hint :  What is the locus of all lines that pass through P and intersect line u?

Details :

	Create the plane passing through P and line u.

Create the plane passing through P and line v.

Find the intersection of these two planes : this line will pass through P and intersect both u and v.
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Extension :

What happens as u and v approach being parallel ?  Perpendicular ?  What happens if they intersect ?

Problem 2 :  

Create two skew lines u and v and now create a line which intersects both lines at right angles.

This is a rather harder problem than the first one.  It may be useful to first hide the base plane and vectors and the points defining the line.  

Hints : 

1. First, find any line which is perpendicular to both u and v.  This will give you the direction of the required line.  

2. Now, find all possible lines with this direction which contain one of the original lines and consider intersections with the other line.

Details :

	Create an arbitrary point M on u and N on v. 

Construct the plane perpendicular to u passing through M (the blue dotted plane).

Construct the plane perpendicular to v passing through N (the olive green plane).  

Now construct line w, the line of intersection of the two planes.  

This line will be perpendicular to both lines u and v.
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	You may want to hide the two planes you have just constructed.  

Construct a line t parallel to w passing through N (or any other arbitrary point on v).

Now construct the plane containing the lines v and t (the blue plane with white holes). 

This plane must contain the required line.
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	Line u must intersect the required line – hence the intersection R between this plane and line u is on this line. 

The line from R must be in the same direction as line w, so construct the line passing through R parallel to w, and construct its intersection S with line v. 

The line RS is the required line.
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	Here is RS viewed from another angle with the final plane hidden :
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A few further explorations with Cabri 3D :
1. Find out about polyhedra which are duals.  Explore the relationships between duals. What implications does this have for their construction ?

2. Which polyhedra will fill space ?  A cube is the obvious example.  What sort of gaps are left by polyhedra which don’t fill space ?

3. The Platonic solids are a very small minority of the solids that have been created and named.  Find out about other solids and see which ones you can create using Cabri 3D.  (Some of these you may have created already by means of truncation).  Can you create any of these via nets that can be folded ?

4. Genevieve Tulloue has created a wealth of 3D shapes and models using Cabri 2 and 2+, to be found at her websites www.sciences.univ-nantes.fr/physique/perso/gtulloue/  and www.gtulloue.free.fr/Cabri3D/ .  Can you reproduce or extend any of these using Cabri 3D?
5. Cones and conic sections.  For example :

	Graph the curve y = x^2 as shown.

This curve is a conic – can you find the cone ?
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6. Eric Bainville’s method for constructing a dodecahedron from a cube was inspired by a diagram in Book 13 of Euclid’s Elements.  There are a number of other polyhedra constructions in this book, and some excellent websites that describe the book…  

7. Claude in the playground.  Claude currently can go on the swing and the trampoline – what else can you make Claude do ?

Appendix 1 :  Cabri 1.0.1 construction of a pyramid.

Hint :  You will need a square, with its centre.  You might want to start with the centre and then construct the square.

Details :

	Create two points A and B on the base plane.  

B will be the centre of the square base of the pyramid, and A will be a vertex.

Construct the line that passes through B perpendicular to the base plane.
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	Construct the circle with this line as axis that passes through A.

Now create point C (point symmetry of A in B).

Create point M on the axis of the circle. M will be the apex of the pyramid. 


	[image: image81.jpg]




	Create the plane through A, B and M. 
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	Construct the line perpendicular to this plane through B. 

Construct points D and E where this line intersects the circle
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	Right-click on plane MAB and hide it.
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	Create the four triangles, faces of the pyramid, the polygon ADCE for the base and the eight edges.
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Appendix 2  Cabri 1.0.1 construction of the regular tetrahedron

Regular tetrahedron

The regular tetrahedron has 4 faces (equilateral triangles), 4 vertices, and 6 edges.

Label the point where the base vectors meet O, and create a point A on the base plane. Construct a regular tetrahedron having one face in the base plane, centered in O and having A as a vertex. 

Hints :  

1. Constructing the base triangle :  O will be at the centroid of the base triangle, which is 2/3 of the way from A to the midpoint Q of the opposite edge.  OA will be equal to OB and OC, where B and C are the other vertices on the base plane.

2. Constructing the top vertex D :  Note that QA =QD and D is directly above O.

Details :

	Find the midpoint P between O and A, and reflect this point in O to get point Q, which will be the midpoint of the side of the triangle opposite A.  

Note that OA = 2*OQ. 
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	Create the segment AQ and the circle with centre O and radius point A 

(use the vertical vector from O as axis for this circle).
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	Construct the plane perpendicular to AQ passing through Q and find its intersection points with the circle, labelled B and C.
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	Create segment BC and use this as axis to draw a circle passing through A.  

Create the ray from O lying along the vertical vector and find its intersection with this circle.  

This intersection is the top vertex D.
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	Create triangles and segments for faces and sides.
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Cabri 3D is available in the UK from Chartwell-Yorke Ltd, 114 High Street, Belmont Village, Bolton, Lancashire, BL7 8AL, tel 01204 811001, fax 01204 811008, orders@chartwellyorke.com, www.chartwellyorke.com.
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